
Using IFT-Consume for Landscape
Smoke Management Planning



Overview & Background
Modeling the consumption of fuels and subsequent
emissions is an important step in planning for smoke
management. Running fuel consumption and emission
production in IFTDSS can provide insight into potential
emissions generated when a given area burns, as well
as gauging the emissions impacts of fuels treatments by
modeling consumption using pre and post treatment
fuels data. IFTDSS workflows are laid out to either cal-
culate fire effects at the stand level (Fire Effect-
s>Calculate consumption or emissions), or at the
landscape level (Fire Effects>Fire effects across the
landscape). To calculate fire effects at the landscape
level, you will run IFT-Consume.

IFT-Consume is a decision-making tool designed to
assist planning for prescribed burns and wildfires using
fuels data. IFT-Consume predicts fuel consumption, pol-
lutant emissions, and heat release based on input fuel characteristics, lighting patterns,
fuel moistures and other environmental variables. IFT-Consume includes separate equa-
tions for calculating consumption of activity and natural fuels. IFT-Consume may be
used to generate consumption and emissions data across the landscape, while Con-
sume for Activity Fuels or Natural fuels may be used to generate information on the
stand-level.

This tutorial will focus on predicting consumption and emissions using Consume. It will
provide information and step by step instructions on the following:

l Setting up a project

l Acquiring FCCS fuelbed data to run IFT-Consume

l Selecting -IFT Consume from the IFTDSS workflows

l Populating and running the IFT-Consume model

l Viewing output data

l Exporting data as raster layers to ArcMap for analysis

l Evaluating results (in ArcMap)

l Review and wrap-up



Setting up the project
To begin, click Create a New Project from the actions menu.

Choose a descriptive project name.

If desired, fill in the optional information.

Choose Next.



After creating a new project, you will see the page for creating a new run. 

For the next steps, setting up an area of interest and acquiring LANDFIRE data, we are
going to navigate to the project summary page by clicking on our project name (circled in
red).



In the Area of Interest window of the Project summary page, choose to define your pro-
ject area of interest by Manually defining the project.

Navigate to your desired location using one of these methods:



l Use the navigation tools located in the top left portion of the map.

l Use the mouse.  Click and drag to move; double-click to zoom in.

l Enter coordinates.

For this example, we will select the following coordinates

North: 48.34953368145102

South: 48.24904128853667

West: -121.8202500471653

East: -121.57580424635472

   Note   
To navigate to your desired location and select a project area using your
mouse instead of typing coordinates, do the following: first click and drag,
then double click to zoom into the approximate area of the map. Next, select
the Draw Box radio button on the top left of the map, mouse to the edge of
your intended project area, hold down the left mouse button, and drag over
your area of interest, then let go of the mouse button.



   Note   
Once you select your dataset, the project area cannot be changed. To
change a project area, you must create a new project.

When finished, click Next at the bottom of the page, this will return you to the project sum-
mary page.

Next we will acquire the Fuels Characteristic Classification System (FCCS) fuelbed data
needed to run Consume.



Acquiring FCCS fuelbed data to run IFT-
Consume
From the Project Summary page, select Import Fuelbeds from LANDFIRE.

   Note   
You may also import LANDFIRE Fuelbeds, or upload a fuelbed dataset by
clicking the Data tab and selecting Fuelbed data tab.

On the ‘Acquire Data from LANDFIRE’ page, choose a name for your dataset, and the
version of LANDFIRE you want to use. For this example we are downloading
LANDFIRE 2010 version 1.20. When finished, click Acquire.



Once the data have downloaded you will be returned to the project summary page.

Next you will scroll down to the Runs section of the project summary page.



Selecting IFT-Consume from the IFTDSS
workflows
Select Create New Run

From the Create New Run menu, Select Prescribed Burn Planning, Fire Effects, Cal-
culate fire effects across a landscape (IFT-Consume).

   Note   



Within the Prescribed Burn workflow under fire effects, there are several
run options using the Consume fire effects model, depending on the inputs,
outputs, and output format desired. These are detailed elsewhere in IFTDSS
help.

Name your Run, ensure the coordinates are corrects, and click Next.

Confirm that the fuelbed data set selected by default is the one which you created for this
project. You are given the option of populating additional information such as burn unit
name, size, etc. For this example we will leave these blank. Click Next.





Populating and running the IFT-Con-
sume model
The parameters needed to run the IFT-Consume model for landscapes are listed in the
table below: 

Name Units Brief Description
Duff Mois-
ture

Percentage The moisture content of duff, expressed as a percentage
of oven dry weight.

Eco Region (A choice) Fuelbeds are organized geographically into Bailey’s eco-
region divisions, which are

l Hot Continental

l Marine

l Mediterranean

l Prairie

l Rainforest

l Savanna

l Subarctic

l Subtropical

l Temperate Desert

l Temperate Steppe

l Tropical/Subtropical Desert

l Tropical/Subtropical Steppe Desert

l Tundra

l Warm Continental
Moisture of
1000-hr
Fuels

Percentage The moisture content of sound, woody material 3 to 9
inches in diameter. Moisture content can be directly
measured or estimated using the ADJ-Th or NFDRS-Th
fuel moisture models.

Percent
Canopy
Loading
Consumed

Percentage Percentage of canopy loading consumed by the fire.

If you do not know the value and choose not to enter this
variable, Consume uses the following defaults:

Prescribed burn = 0%
Wildland fire use = 40%
Wildfire = 60%.



Name Units Brief Description
Percent
Shrub
Blackened

Percentage Percent of the shrub stratum that is blackened by the
burn. This value is input (as a percentage) to the
algorithm for calculating shrub consumption.

For this tutorial, we will use the inputs displayed below. We'll select dry conditions,
including a 1000-hr woody fuel moisture of 16, and a Duff fuel moisture of 5. We'll
assume a scenario in which 50% of the canopy is consumed, and 90% of shrubs are
blackened. For the consumption equation options (Boreal, Southern, or Western) we
will chooseWestern, as it best represents the area of the burn. We will leave the Emis-
sion Factor Group set to its default setting.

   Note   
There are several Emission Factor Groups available. For more information
on the Emission Factor groups, visit the Emission Factor Groups by Cover
Type and the Emission Factors by Emission Factor Groupspages.



Once these inputs are done, click Next

Before the Consume model runs you will have a chance to review the fuel bed (FB) data

On this page you may use the data as is, or make edits to it using the mapping toolbar. In
this example we will leave the data as-is, scroll to the bottom of the page, and click next.

If you choose to edit the data within the map interface during a run, the changes
will take effect during the run. However, the original data file will remain unchanged. To
make permanent changes to a dataset, use the Data Studio feature under the Data tab
of IFTDSS.

   Note   
Visit the FCCS Fuelbed Overview Page if you would like further information
on fuelbeds.



Viewing output data
IFT-Consume will list several emissions:

Name Units Brief Description
Carbon
monoxide
(CO)

Tons per acre,
kg per meter
squared

Total carbon monoxide emitted.

Carbon diox-
ide (CO2)

Tons per acre,
kg per meter
squared

Total carbon dioxide emitted.

Methane
(CH4)

Tons per acre,
kg per meter
squared

Total methane emitted.

Non-meth-
ane hydro-
carbon
(NMHC)

Tons per acre,
kg per meter
squared

Total non-methane hydrocarbons emitted.

Particulate
matter (PM)

Tons per acre,
kg per meter
squared

Total particulate matter emitted.

Particulate
matter 2.5
(PM2.5)

Tons per acre,
kg per meter
squared

Total particulate matter 2.5 emitted.

Particulate
matter 10
(PM10)

Tons per acre,
kg per meter
squared

Total particulate matter 10 emitted.

When the model is finished running, you can view the outputs spatially.



On the dropdown list to the left, we have the option of viewing total particulate matter,
coarse particulates (PM10), fine particulates (PM2.5), carbon monoxide (CO), carbon diox-
ide (CO2), methane (CH4), and non-methane hydrocarbons (NMHC). PM 2.5 is dis-
played below.



To change the display color, or adjust the range of values displayed, select the edit
option in the legend.



To prepare for the next step, click Finish at the bottom of the page, this will take you to
the Run Summary page.



Exporting data as raster layers to
ArcMap for analysis
To download shapefiles or raster versions of the consume inputs and outputs, scroll
down to the Data Sets box of the Run Summary page

Download the raster datasets of the consume inputs and outputs:

1. Select Download under Actions

2. Select your desired format (raster for this example). You will see the export pro-
gress indicated as a percent

3. Once the export process has completed, the percent progress will be replace by a
Download icon. Click the download icon to download a zipfile.



Evaluating results
For this next section, we will evaluate results in ArcMap.

Place your saved input and output zip files in a folder of your choosing, and unzip the
datasets

Open Arcmap

   Note   
Your Arcmap menus may look different than those depicted in this tutorial,
depending upon the version of Arcmap you are using.

Use the Add data tool (circled in red) to find the folder with the exported Consume
inputs and outputs. For this example we will download the FB (Fuelbed) layer from
inputs. From outputs we’ll download consumption layers for duff, litter, woody fuel,
sound woody fuel, rotten woody fuel, and canopy, as well as the total particulate
matter layer. This process is displayed in the images below:



   Note   
These layers are saved as IMAGINE files. To generate an attribute table, or
perform quantitative analysis, you will have to convert them to integer format
by opening Geoprocessing>ArcToolbox >Spatial Analyst> Math>Int.

   Note   



The fuel bed layer, as imported from IFTDSS, will list fuelbeds by their
FCCS number only. However, if you have a corresponding database file of
FCCS fuelbeds in your area, their numbers, and names, it can be joined to
the IFTDSS fuelbed layer and exported as new layer; this will allow you to
identify fuelbeds by name across your landscape.

Right click on fuelbed layer and select join.

Specify which fields to join, in the example below the VALUE field of the imported
IFTDSS fuelbed layer corresponds to the FCCS number (Field 3) of an FCCS text file
that was available for the area in this example. If you are using a table that has more
FCCS fuelbeds than your imported IFTDSS fuelbeds layer, make sure to select the join
option Keep only matching matching records is selected. Select OK.

To make the join permanent, export the joined fuelbed layer by right clicking, select
data, and export data. Ensure your extent and spatial references are set to use the ori-



ginal (Raster Dataset (Original)), and Cell Size is 30 by 30, and the format is set to
GRID, as they are in the figure below. Select Save.

For this example, we have joined the fuelbed names to the FB data layer, and exported
the result as new raster file so that fuelbed names are visible on the landscape.

Right click on each layer, select properties>symbology, and adjust the color and dis-
play to your preference. In this example we selected the total particulate layer, and selec-
ted stretched and chose a color scheme ranging from green to red as the values
increased. This will show where on the landscape the highest particulate matter con-
centrations would be produced.



By toggling back and forth between the fuelbed layer and the particulate matter layer,
and using the identify tool (circled in red) we can see the fuels which are likely to pro-
duce the greatest quantities of particulate matter, that could potentially impact human
health, or regulatory compliance.



We can see in the mountains to the north of the valley, the fuelbeds and high particulate
matter areas match well. Using the identify tool, we can see that the fuelbed predicted to
generate these levels of particulate matter is Fuelbed 2, ‘Douglas fir-Western redcedar-
Western Hemlock’.

By using the same sliding color scale to see the relative highest amounts of various
fuels, we see Fuelbed 2 also corresponds well to high quantities of litter, duff, and sound
woody fuel consumed, but not necessarily fine woody fuel consumption. This provides



information on the specific fuels in these areas that would contribute to particulate emis-
sions.

These choices are just examples, feel free to explore, using a similar approach for your
own area of interest, evaluating different fuels, fuelbeds, and emissions. Doing so will
allow you to identify areas of interest, and potential fuel characteristics.

To use this feature to compare emissions from pre and post-treatments, go through the
process outlined in this tutorial using your pre-treatment data. When finished, save your
outputs ...... Then create a new run using post-treatment data and compare the outputs.



This comparison can be useful in both identifying areas of the landscape that are likely
to produce high levels of emissions, and the differences in emissions between treated
and untreated areas.



Review
In this tutorial we walked through the steps needed to predict consumption and emis-
sions using Consume. The tutorial provided information and step by step instructions on:

l Setting up a project

l Acquiring FCCS fuelbed data to run IFT-Consume

l Selecting -IFT Consume from the IFTDSS workflows

l Populating and running the IFT-Consume model

l Viewing output data

l Exporting data as raster layers to ArcMap for analysis

l Evaluating results (in ArcMap)

Additional Help
To navigate to additional tutorials in the IFTDSS online help content,

1. Click the Help button.

2. Then select Getting Started (Tutorials and Videos) from the side menu.

On that page, you’ll find links to tutorials and videos on such topics as hazard analysis,
prescribed burn planning, fuels treatment, spatial analysis across a landscape, and
many more.
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